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Message from M&E advisor, HIV/AIDS Services Project 

 

The Ministry of Health and Social Welfare (MOHSW), with its support from The Japan International 

Cooperation Agency (JICA), has commenced a four-year project entitled “Health Systems Strengthening 

for HIV and AIDS Services Project” since October 2010.  One of the components of the project is to 

strengthen the HIV and AIDS Monitoring and Evaluation (M&E) system through modeling exercises in 

Dodoma and Pwani regions.  

 

M&E system of the project is composed of the data feedback and data utilization. Data have to be 

returned to the data source with an interpretation after being analyzed and visualized in order for the 

people who collect the data to understand the situation of their community. The findings of the data 

analysis are expected to be utilized to improve the health services by the health management teams.  

 

Although the concept is quite unique and challenging to all of you, we hope that the knowledge and 

skills acquired through this training will be applied to your routine work once you return to your field. 

 

Eventually that all the efforts will come together to improve the health services in your community. 

 

 

September 2012 

 

TANAKA, Ayuko Dr.PH, MPH, MSc 

Epidemiologist/ M&E Advisor 

Health Systems Strengthening for HIV and AIDS Services Project 
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Course Description 

The course is made particularly to strengthen the capacity of data analysis and data feedback at 

Regional Health Management Teams and Council Health Management Teams by use of MS Excel 2010. 

Among a number of HIV/ AIDS related indicators, Score Card Indicators selected by National AIDS 

Control Programme will be applied as data. Throughout the course, participants will be guided to the 

process to analyze and visualize their data timely and accurately. 

 

Course Objectives  

At the end of the course, students should be able to 

1) Maintain IT equipment properly 

2) Comprehend the basic MS Excel functions 

3) Acquire the skills of making tables and charts through MS Excel 

4) Acquire the skills of statistical data analysis through MS Excel 

5) Analyze data by use of Score Card Indicators 

6) Produce data feedback materials for health facilities by use of Score Card indicators 
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Lesson Plan of Computer Course Programme – Data analysis and Production of feedback materials 

Tutor: DAUDI MLAULE AND JUMA HANZURUNI for Basic & Intermediate     
Objectives: The students will be introduced to concepts of Information Technology and be able to start, use, shutdown and maintain the computer 

properly, be able to work in spreadsheets, formatting and laying out data and carry out statistical and mathematical calculations to a level 
matching to their needs and abilities, and be able to make feedback material based on above mention skills and knowledge 
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Day Topic Teacher Activity  Learner Activity  Resources

Day1 1.PC General instruction and Proper Maintenance Exercises on PC General instruction and Proper Maintenance

Information Technology concepts.

Hardware Management to Improve System performance.

Introduction to Computer and its parts including Keyboard and  Mouse, how they work and maintain them.

Starting, restarting, hibernating, standby and shutting down the computer, adjustment.

Folder & file management (creating, copying , renaming, moving, erasing, restoring and search).

Data storage & backup (HD, external HD, USB memory flash etc.).

Managing User Accounts.

Creating, Changing account type, setting and removing passwords, Erasing accounts. Definition and Application of AntiVirus.

2.Introduction to spreadsheet program (MS Excel ver. 2010/ Windows 7)  "What is MS Excel? "

<Managing Workbook> Creating, Saving, copying, renaming, moving, erasing workbooks. Exercises on Managing Workbook

<Managing Worksheet> Creating/inserting, copying, renaming, moving, erasing worksheets and tab color worksheets. Exercises on Managing Worksheet

Screen structure ( title-bar, menu-bar, row number, column number, scroll-bar, clip board, status-bar, formula bar, cell and active cell, mouse pointer, name box, 

question box, worksheet-tab, minimize button, maximize and restore down button, close button, help button etc.)

Navigating menu using a mouse and keyboard.

Entering, Copying, Cutting, Pasting the data and maintaining them on the worksheet using clip board and short-cut key.

Inserting rows and columns, Adding borders and filling color, Formatting cells and Conditional formatting, if functions and lookup formulas. Exercises and Tests on basic operation of PC and MS Excel

Day2 1.Introduction to making  "MS Excel Database" and its basic theory. " What is Excel database? " Exercise on how to make a database

2.Introduction to basic formulas (addition, subtraction, division, multiplication, exponentiation, sum, count) Exercises on how to work with basic formula and tabulation

3.Introduction to basic statics values (Mean, Standard error, Median, Mode, Rage, Maximum, Minimum, Standard deviation ) Exercise on creating Excel table by formatting borders and shading and deleting a table

4.Introduction to tabulation using MS Excel Exercise on formatting and printing a table

5.Introduction to making  tables in MS Excel and its basic theory.  "What is table ? " Exercises and Tests on creating a table using tabulating data

Day3 1.Introduction to graphing data and its basic theory. "What is graph/chart ? " Exercise on selecting and creating suitable graph/chart based on purpose

Types of graph/chart and concept of each graph/chart e.g. Columns, Bar, XY and others Exercise on formatting and printing graph/chart

2.Introduction to Data Analysis using MS Excel.  "What is data analysis ? "

Analyzing data in MS Excel and explaining what they mean. 

Exercises on how to work with Correlation Coefficient, Scatter chart and Regression formula 

and Hypothesis testing

3.Introduction to Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing e.g. t-test and z-test, Once comfortable carry 

out additional tasks supplied by the tutor 

Exercises and Tests on creating graph/chart and how to work with Correlation Coefficient, 

Scatter chart and Regression formula and Hypothesis testing

Day4 1.Introduction to making presentation format in MS Excel Exercises on producing feedback materials 

Organizing table, graph/chart and description in A4 paper, printing them out as feedback materials

2.Facilitation for producing feedback materials Production of feedback materials using own SCI data 

Day5 1.Facilitation for producing feedback materials Production of feedback materials using own SCI data 

Presentation of produced  feedback materials

2.Suggestion with encouragements on the presented materials Suggestion with encouragements on the presented materials
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Whiteboard

How-to manual on Excel 

Interactive whiteboard

Digital Projector

Additional exercises on 

covered items

Pictorial handout on menus 

and their meanings

Color Printer & printing 

paper 

Physical parts of computer 

(e.g.HDD, RAM, CPU, 

Case, and Motherboard 

etc.)

Whiteboard

Digital Projector

Practical exercises

Color Printer & printing 

paper 

P
C

 g
en

er
al

 in
st

ru
ct

io
n 

&
 M

S
 E

xc
el

 b
as

ic
 fu

nc
tio

n
D

at
ab

as
e,

 b
as

ic
 fo

rm
ul

a 
an

d 
st

at
ic

s 

va
lu

e,
  t

ab
ul

at
io

n 
an

d 
ta

bl
e

D
at

a 
an

al
ys

is
 a

nd
 

gr
ap

h/
ch

ar
t



 

 

 

 

TIME TABLE 
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Day Start

Time

End

Time

Activity/Topic Responsible Person

Day 1 8:00 8:30 Participants arriving and registration All

8:30 9:00 Opening Remarks, logistics, Self-Introduction, Training schedule UCC Arusha Branch Manager, NACP/JICA

representative

JICA HIV/AIDS M&E activities and Purpose of the training, Today's target and schedule NACP/JICA representative

9:00 10:30 PC General instruction and Proper Maintenance Daudi Mlaule and Juma Hanzuruni

Introduction to Computer and its parts including Keyboard and  Mouse, how they work and maintain them

Starting, restarting, hibernating, standby and shutting down the computer, adjustment),  Folder & file management (create,  copying , renaming, moving, erasing,

restoring and search), Data storage & backup (HD, external HD, USB memory flash), Desktop management (Taskbar setting, Screen Wallpaper, Screen Saver,

Clock adjustment)

Optimizing computer performance by Disk defragmentation, error checking and cleanup

10:30 11:00 Tea Break All

11:00 13:00 Managing User Accounts Daudi Mlaule and Juma Hanzuruni

Creating, Changing account type, setting and removing passwords, Erasing accounts. Definition and Application of AntiVirus Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Introduction to spreadsheet program (MS Excel ver. 2010)  "What is Excel? " Daudi Mlaule and Juma Hanzuruni

Worksheet and Workbook, Screen structure ( title-bar, menu-bar, row number, column number, scroll-bar, clip board, status-bar, formula bar, cell and active cell,

mouse pointer, name box, question box, worksheet-tab, minimize button, maximize and restore down button, close button, help button etc.), Navigating menu using

a mouse and keyboard

Creating, Saving, copying, renaming, moving, erasing workbooks

Entering, Copying, Cutting, Pasting the data and maintain them on the worksheet using clip board and short-cut key

Inserting rows and column, Adding borders and filling color, Formatting cell and Conditional formatting, if functions and lookup formula.

Creating/inserting, copying, renaming, moving, erasing worksheets and tab color worksheets

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on basic operation of PC and MS Excel Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 2 8:00 9:00 Recap for day 1 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:30 Introduction to making a "MS Excel Database" and its basic theory. " What is Excel database? " Daudi Mlaule and Juma Hanzuruni

Exercise on how to make a database Students/Participants

Introduction to basic formula (addition, subtraction, division, multiplication, exponentiation, sum, count) Daudi Mlaule and Juma Hanzuruni

Introduction to basic statics values (Mean, Standard error, Median, Mode, Rage, Maximum, Minimum, Standard deviation ) do

Introduction to tabulation using MS Excel do

Exercises on how to work with basic formula and tabulation Students/Participants

10:30 11:00 Tea Break All

11:00 13:00 Introduction to making  tables in MS Excel and its basic theory.  "What is table ? " Daudi Mlaule and Juma Hanzuruni

Exercise on creating Excel table by formatting borders and shading and deleting a table Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Exercise on formatting and printing a table Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on creating a table using tabulating data Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants
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Day Start

Time

End

Time

Activity/Topic Responsible Person

Day 3 8:00 9:00 Recap for day 2 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:30 Introduction to graphing data and its basic theory. "What is graph/chart ? " Daudi Mlaule and Juma Hanzuruni

Types of graph/chart and concept of each graph/chart do

Exercise on selecting and creating suitable graph/chart based on purpose Students/Participants

10:30 11:00 Tea Break All

11:00 13:00 Exercise on formatting and printing graph/chart Students/Participants

Introduction to data analysis using MS Excel.  "What is data analysis ? " Daudi Mlaule and Juma Hanzuruni

13:00 14:00 Lunch Break All

14:00 15:30 Introduction to Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Daudi Mlaule and Juma Hanzuruni

Exercises on how to work with Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Exercises and Tests on creating graph/chart and how to work with Correlation Coefficient, Scatter chart and Regression formula and Hypothesis testing Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 4 8:00 9:00 Recap for day 3 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

9:00 10:00 What is data feedback ? NACP/JICA representative

10:00 10:30 How to produce feedback materials using MS Excel Daudi Mlaule and Juma Hanzuruni

10:30 11:00 Tea Break All

11:00 13:00 Exercises on produce feedback materials Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Exercises on producing feedback materials (Continued….) Students/Participants

15:30 16:00 Evening Tea All

16:00 17:00 Produce feedback materials using own SCI data Students/Participants

17:00 18:00 Free to use Computer Lab/Class for any Private reading Students/Participants

Day 5 8:00 8:30 Recap for day 4 and Today's target and schedule Daudi Mlaule and Juma Hanzuruni

8:30 9:30 Produce feedback materials using own SCI data (Continued….) Students/Participants

9:30 10:30 Presentation of produced materials Students/Participants

10:30 11:00 Tea Break All

11:00 11:30 Suggestion with encouragements on the presented materials Daudi Mlaule and Juma Hanzuruni

Students/Participants11:30 13:00 Final Examinations Students/Participants

13:00 14:00 Lunch Break All

14:00 15:30 Discuss the way of data feedback. Students/Participants

The way forward of the project activities NACP/JICA representative

15:30 16:00 Evaluation of the training Students/Participants

16:00 16:30 Course Summary Daudi Mlaule and Juma Hanzuruni

16:30 17:00 Evening Tea All

17:00 18:00 Getting Final examination results and Certificate *for all participants and for who passed the examination Students/Participants and facilitator

Closing All
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Abbreviations & Terminology 
 

ITEM  MEANING 

ADSL  Asymmetric Digital Subscriber Line 

Bit  1 or 0 level of storage is called a bit 

BPS  Bits Per Second 

Byte  A measurement of storage capacity 

CBT  Computer Based Training 

CD  Compact Disk 

CD-R  Compact Disk - Recordable 

CD-ROM  Compact Disk - Read Only Memory 

CPU  Central Processing Unit 

DAT  Digital Audio Tape 

DOS  Disk Operating System 

DSL  Digital Subscriber Lines 

DVD  Digital Versatile Disk 

FTP  File Transfer Protocol 

G Byte  Gigabyte. A gigabyte consists of 1024 M Bytes 

G Hz  Measurement of computer speed. Gigahertz 

GUI  Graphical User Interface 

Hz  Hertz (this is a measurement of frequency (i.e. speed). 

IS  Information Systems 

ISDN  Integrated Services Digital Network 

IT  Information Technology 

K Byte  Kilo byte. A kilobyte (KB) consists of 1024 bytes. 

LAN  Local Area Network 

M Byte  Megabyte. A megabyte (MB) is one million bytes 

MHz  Million Hertz 

PC  Personal Computer 

PSTN  Public Switched Telephone Network 

RAM  Random Access Memory 

ROM  Read Only Memory 

ROM-BIOS  Read Only Memory - Basic Input Output System 

RSI   Repetitive Strain Injury 

T Byte  Terabyte. A terabyte (TB) is one million M Bytes 

UPS  Uninterruptible Power Supply 

USB  Universal Serial Bus 

VDU  Visual Display Unit 

WAN  Wide Area Network 

WWW  World Wide Web 

vi 
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Using Computer 

Starting the Computer 

 
• Ensure that all cables are plugged securely into the rear of the machine. 
• Make sure that there is no disk inserted in the CD/DVD drive. 
• Locate the power switch and turn the computer on. 
• After a few seconds, you should see something on screen. If not ensure that the monitor is switched on. 
 
 
SHUTTING DOWN THE COMPUTER 

  
  
 
 
 
• Click “Start” button 
• Click “Shut down” 
 
 

To shut down a computer 
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PARTS OF THE WINDOW 

 Make sure that you can identify: 

o Office Button 

 

o Quick Access Toolbar 

 

o Title Bar 
 

o WINDOW CONTROL BUTTONS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SAVING A FILE TO DISK 

 When you use a Microsoft application, such as Word, PowerPoint or Excel, 
then by default the files that you save will be saved in a folder called 
“Documents” 
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SELECTING FILES or FOLDERS 

 

• To select adjacent files/folders; select in combination with 
“shift key” 

• To select non-adjacent files/folders; select in combination 
with the “control key” 

• Copying files or folders between folders and between 
drives 

Use either “Copy and Paste” or use “Drag and Drop” 
technique 

• To copy (Within a drive) 

Drag and drop a file or folder while keeping the control 
(CTRL) key pressed 

 
MOVING FILES 
 

• Use either "Cut and Paste" / Use "drag and drop" techniques 

• To Move (within a drive) 

Drag and drop file or folder 
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Security Issues 

Computer logon user name (ID) and password. 
Passwords:  
If your computer has a password that prevents other users from accessing it then do NOT give this password 
to anybody else. Do not write the password on a card and prop this up next to the monitor and above all do 
not attempt to hide your access passwords on the underside of your desk (this is the first place most criminals 
would look if trying to break into your system). Make sure you do not forget your passwords; in many cases, 
data cannot be recovered once the password is lost. 
 
User IDs and passwords:  
A User ID is normally used to logon to a computer, or computer network. It uniquely identifies you to the 
network. In addition you use a password that is only known to you. The password guarantees that no one can 
access the network and impersonate you (in theory). Once you have logged on (i.e. connected) to the rest of 
your computer network, you will have been assigned access rights to the network. Your network 
administrator will have defined these access rights. The idea of access rights is that you only have the ability to 
connect to, or share, devices that you have authority to use. In other words, the network administrators often 
have access rights to just about every computer, printer, modem etc. on the network. You on the other hand 
may have access rights to print to only certain, specified printers and you may be able to access only certain 
data held on the network. 
 
Passwords: 
Your password is the only thing that will prevent someone else logging into a computer using your user ID and 
impersonating you. It is important to choose a password that cannot be easily guessed by other people. 
Ideally a password should be at least 8 characters long & contain a mixture of words and numbers. It is also 
recommended that you change your password regularly; some computer systems will require you to change 
your password periodically.  Never share your password with others 
These are procedures to create an account. Click “Start/Windows” logo then click “Control Panel”. Within this 
choose “User Accounts”. Then click “Manage another account”, a panel will open for you to see different 
present accounts. Click “Create new Account”, give it a name, decide whether is to be “Standard” or 
“Administrator” user, then click “Create Account” 
To set a password do the following; Double-click that newly made account, then click “Create a password”. 
Write your desired password and repeat it to confirm at an area given. Password hint is an optional and may 
help you to remember your password. Password Hint is visible even to other computer users. Then click 
“Create Password” 
 
It is no good backing up your data only to leave the item, you backed up to next to the computer; if someone 
steals your computer it is likely that they will also steal your backups too. If you have a fire, then again you will 
lose your backups if the backups are stored next to the computer. Ideally, backups should be stored off-site at 
a safe location. At the very least, consider storing your backups in a fireproof safe, which will give some 
protection against fire damage. 
 
The need for backups: 
The most important thing which you store on your computer is information. Often the contents of a hard disk 
can represent years of work. If the hard disk stops working one day you could lose all those years of work. For 
this reason it is VITAL that you take regular backups of the information that is stored on the computer. In 
large organisations this backup procedure is normally performed automatically by your computer support 
team, where the data is normally held on a centralised, networked computer. 
 
In smaller organisations, it is often up to the individual to organise some sort of data backup. If nothing else is 
available, copy your files to a USB memory stick or CD/DVD disk and make sure that these backups are stored 
away from the computer, ideally off-site. If there is a fire and your office burns down, if your backup disks are 
stored next to the computer they too will be incinerated. 
Disk Clean up-Help in removing unnecessary files from the Hard drive. Follow this procedure; Open “Computer” 
icon on desktop and right-click a drive you want to clean, e.g. C:  after right-clicking click ‘Properties” and 
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under “General” tab click” Disk Clean up”. The computer will calculate the amount of disk space to be freed 
and will give you an option to remove. 
 
Organizing your computer for better backups 
When you think about it, you have a computer containing many programs and also a large amount of data 
that you have created, then it is only the data that really needs to be backed up. If you create a folder 
structure that contains only data then only this folder (plus any sub-folders of this folder) needs to be backed 
up. 
 
Complete vs. incremental backups 
A complete backup means that you backup all the data on your computer. This has the advantage that the 
entire hard disk can be backed up, but suffers from the disadvantage that this process can take a long time if 
your computer contains a lot of data. An incremental backup means that once a week you can perform a 
complete backup, but every night for the rest of the week, you only backup files that have been newly created 
or modified since the last backup, saving time. With the right backup software, this process is automatic, and 
normally you only have to select full or incremental. 
 
Firewalls 
A firewall is a system that secures your network from access by unauthorized users. A firewall can be 
implemented via software, hardware or by a combination of the two. If you are using broadband for Internet 
access, it is vital that some sort of firewall is in place to stop people trying to hack into your computer. 
 
Computer viruses 
Viruses are small programs that hide themselves on your disks (both diskettes and your hard 
disk). Unless you use virus detection software, the first time that you know that you have a 
virus is when it activates. Different viruses are activated in different ways. BEWARE: Viruses 
can destroy all your data. 
 
 Viruses hide on a disk and when you access the disk (either a diskette or another hard disk over a network) 
the virus program will start and infect your computer. The worst thing about a computer virus is that it can 
spread from one computer to another, either via the use of infected disks, or over a computer network. The 
Internet allows you to access files from all over the world and you should never connect to the Internet unless 
you have a virus-checking program installed on your computer. It is vital to keep your virus monitoring 
software up to date. Many anti-virus programs, such as Norton Anti-Virus allow you to update the program so 
that the program can check for recently discovered viruses. 
 
More Information: 
McAfee Anti-virus software http://www.mcafee.com 
Norton Anti-virus software http://www.symantec.com/avcenter 
AVG anti-virus software http://www.grisoft.com/ 
Microsoft Essential Security Anti-virus software  
http://windows.microsoft.com/en-US/windows/products/security-essentials 

There are many ways in which a virus can infect your computer.  A very common way that viruses gain access 
to a computer, is when people download files from the Internet.  Never download files from a website unless 
you are sure that the website can be trusted.  Many anti-virus products now rate websites and mark those 
that are known to distribute viruses, with a warning.   

For the same reason you should never open an e-mail attachment unless the e-mail has come from a trusted 
source.   

Another common route of virus infection is by attaching portable storage disks to your computer that have 
been supplied to you.  In most cases, good up-to-date virus checking software should offer you pretty good 
protection against catching a virus when downloading or sharing files.   

In many organisations, attaching an un-authorised storage device to a computer is an offence that can result 
in dismissal from the organisation.   
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The safest way to use a computer is to not connect it to a Local Area network or the Internet. This is called a 
'stand-alone' computer, providing that you do not use disks on that PC that have been used in other 
computers, this type of computer is virtually immune from any form of intrusion. 

Unfortunately it is the ability to connect to other computers or indeed the Internet, that makes the modern 
computer so versatile and so useful. 

Always make sure that all computers require an ID and password to access them. Make sure that all relevant 
'security patches' from Microsoft have been applied. 

Make sure that the password is long enough, contains a random mixture of numbers and letters, and that the 
passwords are changed on a regular basis.  

There are many examples, where people have used passwords that relate to something personal, such as a 
partner’s first name, the dog’s or cat’s name, etc. For a determined, serious computer hacker, these are easy 
to guess. If you have a system, where lots of different passwords are required to access the system, then 
security often breaks down and computer users will sometimes keep a list of these passwords in their disk. 
This defeats the whole object. If you forget your network access password, the network administrator should 
be able to assign you with a new one. 

If you discover a virus on your computer don’t panic. If your virus checker alerts you to a virus, then the 
chances are that it has caught the virus before the virus could infect your computer and cause damage. For 
instance you may insert a disk into your computer and the virus checker should automatically scan the disk. If 
the disk contains a virus, a message will be displayed telling you that the disk is infected, and it should 
automatically remove the virus. The other common method of infection is via emails. 

If you work within a larger company, you should have a company IT support group 
that will come and rid your computer of viruses. Be sure that you are familiar with 
your company’s policy regarding viruses. 

Anti-virus software can only detect viruses (or types of viruses) that the software 
knows about. As such it is vital that you keep your Anti-virus software up to date so 
that it can detect new viruses that are constantly appearing. 
 
  
Malware 
The word Malware is a combination of the words "malicious" and "software".  Malware is software designed 
to install itself and run without your consent and without your knowledge.  Sometimes when you download 
free programs from an internet site, they come bundled with hidden programs that you did not ask for and 
will not want.  Often these hidden programs send back marketing information to companies.  Sometimes they 
may have more sinister purposes, such as sending your credit card details to criminals intending to steal from 
you. 

When installing free programs you find on the net always read the licensing terms, as often the malware 
content is hidden away within this long document. 
 
Spyware 
This is different from a virus.  Details such as your online browsing habits can be sent, without your knowledge, 
to marketing companies, or even criminal organizations that will try to get information such as your credit 
card details or access passwords. 
 
Worms 
A computer worm is a self-replicating computer program that sends copies of itself to other computers via a 
network.  It can copy itself from computer to computer without your knowledge. 
 
It is different from a virus because it has no need to hide itself within another program. Many worms can 
reduce your available bandwidth due to their copying activities, but otherwise do not actually damage your 
files.  However there are also destructive worms that will attack or compromise your data. 
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Trojans 
A Trojan horse (often just called a ‘Trojan’) is a type of software that you normally expect to do one thing, but 
in fact it does something else that you did not intend.  A Trojan is not a computer virus and does not try and 
copy itself across your network.  It is basically just a program that you need to run.  Sometimes you may run 
this Trojan program when you actually think you are running a legitimate program. The name comes from the 
classical story of the wooden Trojan horse. 
 
Scare ware 
These are popup messages that you may see displayed within a web browser, such as Internet Explorer, that 
falsely warn you that your computer is infected with a virus or spyware.  They invite you to you click on the 
popup link to solve the problem and then ask you to pay for software that will allegedly fix the problem.  In 
many cases the software that you then purchase is useless. 
 
NOTE: Do not confuse scare ware scams with legitimate popup messages from the virus checking program 
that is installed on your computer. 
 
Hardware 
The term hardware refers to the physical components of your computer such as the system unit, mouse, 
keyboard, monitor etc. 
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Parts of a computer 

You should understand some of the basic elements that make up a computer including:  
 
- Central processing unit (CPU). 
- Types of memory. 
- The hard disk. 
- Input and output devices. 
 
The CPU (Central Processing Unit) 
Normally an Intel chip (or equivalent) and it is one of the most important components within your computer. 
It determines how fast your computer will run and the CPU speed is measured by its GHz speed. Thus, a 4 GHz 
CPU is much faster than say a 1 GHz CPU. It is the CPU that performs all the calculations within the computer, 
when running programs such as word-processors, spread sheets and databases.   
 
The CPU contains the following elements:  
 
Control Unit:  
The control unit is responsible for controlling the sequencing and timing of the other elements making up the 
CPU. 
 
Arithmetic Logic Unit (ALU):  
The ALU performs the mathematical calculations using data stored within the CPU  
Registers:  
The registers are memory storage areas within the CPU that hold the data that is worked on by the ALU.  
BUS:  
The computer bus transports data between the memory and registers. 
 
More information: 
Intel: http://www.intel.com 
AMD: http://www.amd.com 
 
 
 
 
RAM (Random Access Memory 
Houses within your computer is where the operating system is loaded to, when you 
switch on your computer, and also where your applications are copied to when you 
start an application, such as a word processor or database program. When you create 
data, such as letters and pictures, these are initially created and held in RAM and then 
copied to disk when you save the data. As a rule of thumb, the more RAM you have 
installed in your computer the better. These days you will commonly find over 2 G Bytes 
of RAM installed. 
  
Disks 
You use disks to store any data that you create.  This can range from a memo created within a word processor 
to a video file created using a video camera.  There are many different types of disk.  Software is also supplied 
on disk, normally a CD or DVD disk. 
 
Hard disks are the main, large data storage areas within your computer. Hard disks are used to store your 
operating system, your application programs (i.e. your word processor, games etc.) and your data. They are 
much faster than CD or DVD disks and can also hold much more data.  Hard disks are installed within the 
system unit of your computer. 
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Input and Output ports 
Normally located at the back or on the side of your computer.  These include ports such as USB, serial, parallel, 
network and FireWire ports.  You plug cables into these ports to connect your computer to other devices, 
such as printers, scanners and cameras. 
 
The Universal Serial Bus 
You will see one or more USB sockets at the back of the system unit, allowing you to 
plug in devices designed for the USB. These devices include printers, scanners and 
digital cameras.  Memory sticks can also be plugged into a USB port allowing you to 
copy data to, or from, your hard disk. 
 
The Serial Port 
The serial port is a socket located at the back of your computer that enables you to 
connect items to the computer, such as a modem. They are commonly labelled as 
COM1 or COM2. 
 
The parallel port 
Is a socket located at the back of your computer that enables you to connect items to 
the computer, such as a printer.  Commonly labelled as LPT1 or LPT2. 
  
 
NOTE: The parallel port used to be the main way the computer connected to a printer.  
These days you are more likely to use a USB cable to connect the computer to a 

printer. 
 
The network port 
Allows you to plug a ‘network cable’ into your computer, which then lets you 
communicate with other computers connected to your local network or to other 
computers via the Internet. 
 
  
FireWire 
Is an interface from Apple Inc. that allows high speed data transfer between your 
computer and a compatible device such as a digital camera.  FireWire has largely 
replaced earlier ways of transferring data.  There are numerous 
versions of FireWire including fibre optic, coaxial and wireless versions.  
Most multimedia computers will have FireWire ports built into them.  
Fire wire connectors usually look like this: 
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What is software? 
 
The software is the collection of instructions that makes the computer work. For instance, when you type in 
words via the keyboard, the software is responsible for displaying the correct letters, in the correct place on 
the screen. Software is held either on your computer’s hard disk, CD, DVD or on a diskette (floppy disk) and is 
loaded (i.e. copied) from the disk into the computers RAM (Random Access Memory), as and when required. 
 

 
  

 
What is an operating system? 
 
The operating system is a special type of program that loads automatically when you 
start your computer. The operating system allows you to use the advanced features of 
a modern computer without having to learn all the details of how the hardware works. 
There are a number of different types of operating system in common use. The IBM PC 
(Personal Computer) was introduced way back in 1981 and was originally supplied with 
an operating system called DOS (Disk Operating System). This operating system was 
very basic, and you had to be a bit of a computer expert just to understand how to use 
it. It was NOT user-friendly. Later on, Microsoft introduced Windows and this is the 
operating system which is most widely used on PCs today.  To complicate matters 
further, there are a number of different types of Windows. Most people are today 
running either Windows XP, Windows Vista or Windows 7. 
 
UNIX and Linux are other examples of operating systems that may be run on PCs. 
 
Other types of computers, such as those manufactured by Apple have a completely different operating 
system. 
 
Microsoft Windows: Microsoft: http://www.microsoft.com 
IBM OS/2: http://www.ibm.com/software/os/warp 
Mac OS X: http://www.apple.com 
Linux: http://www.linux.org 
UNIX: http://www.unix.org 
 
Difference between the operating system and application programs  
The operating system works closely with the hardware that you have installed within your computer.  It 
interprets the input via the mouse or keyboard and outputs data to the screen. 
The application programs sit above the operating system, and make use of the functionality built into the 
operating system.  They are specific to a particular task.  For instance Microsoft Word is designed as a word 
processing program, while Microsoft Excel is a spread sheet program. 
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Examples of software applications  
An application program is the type of program that you use once the operating system has been loaded. 
Examples include word-processing programs (for producing letters, memos etc.), spread sheets (for doing 
accounts and working with numbers), databases (for organising large amounts of information), games 
programs and graphics programs (for producing pictures, advertisements, manuals etc.).  
It is important that you recognise examples of application programs covering the following areas: 
 
- Word processing 
- Spread sheets 
- Databases 
- Presentations 
- E-mailing 
- Web browsing 
- Photo editing 
- Computer games 
 
A word processing program (such as Microsoft Word) allows you to produce letters, memos, etc., easily. You 
can easily mail merge a list of names and addresses to produce mass mailers, individually addressed to 
customers or subscribers. 
 
A spread sheet program (such as Microsoft Excel) allows you to work out a company’s income, expenditure 
and then calculate the balance. It enables you to make 'what if' type projections of how the company will fair 
in the future and to forecast how changes in prices will affect profits. 
 
A database program (such as Microsoft Access) allows you to compile information and then to search this 
information to extract just the information you require. For instance, if you have a database of all the 
equipment housed within an office you can very simply produce a report listing only the equipment above a 
certain value. 
 
A presentation program (such as Microsoft PowerPoint) allows you to produce professional looking 
presentations that can be printed out directly onto slides for use with an overhead projector. Alternatively, 
you can display your presentations directly on a computer screen or via a computerised projector. 
 
There are many emailing programs available.  As the name suggests you use these to send and receive emails.  
Microsoft Outlook is supplied within Microsoft Office.  Another well know example is the Thunderbird email 
program. 
 
Applications used to view and interact with the World Wide Web (WWW).  
 
MS Internet Explorer:  http://www.microsoft.com 
Google Chrome:  http://www.google.com/chrome 
Firefox:  http://www.mozilla.org/products/firefox 
 
These programs allow you to edit digital photos.  You can adjust items such as the picture brightness, contrast 
and colour balance.  You can remove defects such the red eye effect often caused when using a flash.  You 
can apply interesting special effects and filters to visually enhance your photographs.  Examples include 
Photoshop from Adobe and Paint Shop Pro from Corel. 
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Computer Performance 

Factors affecting computer performance 
There are a wide range of factors that can affect the performance of your computer.  These include CPU 
speed, RAM size, type of graphics card, plus the number of applications running.  It is important to realise that 
it is not just the speed of the CPU that affect the overall performance of your computer.  There is no point in 
having a very fast CPU if the other parts of a computer may slow down the real world performance.   
 
CPU Clock speed 
The computer clock speed governs how fast the CPU will run. The higher the clock speed, the faster the 
computer will work for you. The clock speed is given in Gigahertz (GHz).  The higher the GHz speed the faster 
the computer. 
 
RAM size 
As a rule the more memory you have the faster the PC will appear to operate. Windows also uses the hard disk 
a lot, so logically the faster the hard disk can operate, the faster the PC will appear to run. 
 
Hard disk speed and storage 
Hard disks are also measured by their speed, defined by the disk access time, which is measured in 
milliseconds. The smaller this access time, the faster the hard disk will store, or retrieve data. The data storage 
capacity of hard disks continues to increase as new products are released. The disk storage capacity is 
measured in Gigabytes (G Bytes). 1 G Byte is equivalent to 1024 Mbytes. 
 
Free hard disk space 
To get the most out of your Windows based PC, you not only need a fast hard disk, but also a large hard disk, 
with plenty of "spare space". This is due to the fact that Windows is constantly moving data between the hard 
disk and RAM (Random Access Memory). Microsoft Windows will create many so-called “temporary files” 
that it uses for managing your programs. In fact, if you have very little free hard disk space, you may find that 
Microsoft Windows will not be able to run your programs at all. 
 
Error-Checking 
 This is a process of scanning the surface of the drive for any bad sectors. It detects and removes any broken 
part of cluster. It helps in increasing the life span of the Hard disk. 
Procedure; 

1. Open “Computer” 
2. Right-click desired drive e.g. C: then click “Properties” 
3. Click “Tools” then click “Error-Checking”. It will either do the process or schedule to run when you restart 

the computer. 
 
Disk Clean up 
Disk Clean up-Help in removing unnecessary files from the Hard drive. Follow this procedure; Open “Computer” 
icon on desktop and right-click a drive you want to clean, e.g. C: after right-clicking click ‘Properties” and 
under “General” tab click “Disk Clean up”. The computer will calculate the amount of disk space to be freed 
and will give you an option to remove. 
 
De-fragmenting files 
Disk Defragmentation help to arrange files in a better way so that it is easy for Operating Software to open it, 
hence improve computer performance.  
If you are running Windows you may find that if you click on the Start menu, select Programs, and then select 
the Accessories / System tools group, there is a de-fragmentation program. Running this periodically may 
noticeably speed up the operation of your PC. When you use a PC, over a period of time the files get broken 
up into separate pieces that are spread all over the hard disk. De-fragmentation means taking all the broken 
up pieces and joining them back together again. 
  
  



15 
 

Multitasking considerations 
Windows is a multitasking system, which means that it can run more than one program at a time. However 
the more programs that are running at the same time, the slower each one will run. To some extent this 
slowing effect depends on what each program is doing. Editing a large high definition video for instance can 
take up a lot of CPU time. 
 
CPU speeds 
The speed (operating frequency) of the CPU is measured in gigahertz (GHz).  The higher the value the faster 
the CPU will operate.  The original IBM PC released way back in 1981 ran at 4.77 MHz whereas modern PCs can 
run at over 4000 MHz, which gives you an idea of how far things have progressed. 
1 MHz means that the device will run at one million cycles per second.   
1 GHz is a thousand times faster, so that 1 GHz = 1000 MHz. 
 
Memory 
What is computer memory? 
You can store data on your hard disk, while data that is being processed is stored in RAM (Random Access 
Memory). Data that is stored on a hard disk can be permanent, while data in RAM is only temporary. Normally 
when people talk about memory in relation to a PC, they are talking about RAM. 
 
RAM 
Random Access Memory (RAM) is the main 'working' memory used by the computer. When the operating 
system loads from disk, when you first switch on the computer, it is copied into RAM. Commonly modern 
computers are supplied with over 2 G Bytes of RAM. As a rough rule, a Microsoft Windows based computer 
will operate faster, if you install more RAM. When adverts refer to a computer having 2 G Bytes of memory, it 
is this RAM which they are talking about. Data and programs stored in RAM are volatile (i.e. the information is 
lost when you switch off the computer). 
 
ROM 
Read Only Memory (ROM) as the name suggests is a special type of memory chip that holds software that can 
be read but not written to. A good example is the ROM-BIOS chip that contains read-only software. Often 
network cards and video cards also contain ROM chips. 
Data Storage 
 
Measurement of storage capacity 
It is important that you understand a little about the measurements used to define storage capacities:  
 
Bit:  
Computers are digital.  This means they work by processing ones and zeros.  The basic one or zero is called a 
bit of information. 
 
Byte:  
There are eight bits in a Byte. 
 
KB - Kilobyte:  
There are approximately a thousand bytes in a KB (also called a K Byte) 
 
MB - Megabyte:  
There are approximately a million bytes in a MB (also called a M Byte) 
 
GB - Gigabyte:  
There are approximately a thousand, million bytes in a GB (also called a G Byte) 
 
TB - Terabyte:  
There are approximately a million, million bytes in a TB (also called a T Byte). 
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Types of storage media 
There are a range of storage media to choose from including CDs, DVDs, USB flash drives, memory cards, 
internal hard disks, external hard disks, network drives and on-line file storage. Some are more suitable than 
others for a particular job, for instance a flash drive is great for quickly transferring relatively small amounts of 
data from one computer to another. 
Internal hard disks 
All PCs are supplied with an internal hard disk.  This is where the operating system (such as Windows) is stored.  
It is also were you store your data.  When you install new applications, they are copied from CD or DVD to your 
internal hard disk. 
  
External hard disks 
As the name suggests these are secondary hard disks that you can plug into 
your computer.  They are normally connected via a USB cable.  They are 
available in a range of speeds and storage capacities and are an ideal way to 
back up your data, such as photos or movies. 
 
CDs 
Most computers are now supplied with a CD drive. CD data discs look exactly 
like music CDs but contain computer data instead of music. The advantage of a CD is that it can hold a vast 
amount of data. The other big advantage of CDs is that they are interchangeable. This means that you can 
own a range of different CDs and choose which one to insert into your CD drive. 
 
DVDs 
Short for "Digital Versatile Disk”. Similar to CD drives but allows you to use DVD disks, which contain vastly 
more information than a traditional CD disk. These also transfer the data from the disk to the computer far 
faster, allowing you to watch movies on your computer screen. A CD disk can store 650 MB of data, while a 
DVD disk can store over 4 GB of data.  
 
USB memory sticks 
Flash drives plug into the USB port and when viewed via the Windows Explorer, 
look just like any other drive.  They are supplied in a range of sizes with the 1 GB 
devices being a very cheap way of transferring relatively small amounts of data 
between computers. 
 
  
 
Memory cards 
A memory card (also called a flash memory card) is a card containing memory chips that is often used in 
devices such as digital cameras, telephones, music players, video game consoles, GPS system and similar 
devices where there is a need to store data in a compact form, often using a battery power source.   There are 
a number of different types of memory cards with different 
storage capacities.   
 
Many new PCs have built-in slots for different types of memory 
cards. 
 
  
 
Network drives and on-line file storage 
Within an office it is normal that the computers are connected together via a network.  This allows you to 
store your data centrally, on a network server.  This network server should be backed-up by the IT support 
staff on a daily basis.  This means that your data is safely backed up for you. 
Alternatively you may create and store your data on your own PC or laptop and periodically copy it across the 
network to be stored safely on a central network server.  In many companies network software automatically 
backs up selected folders on each computer to the central server. 
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Floppy disks (diskettes) 
Floppy disks are also known as diskettes. They are very slow compared to 
hard disks, CD or DVD disks and hold relatively small amounts of data (1.44 
Mbytes). Sometimes people will backup (i.e. copy) important data from 
their hard disk to floppy disks. However, as diskettes are notoriously 
unreliable this is not the best way of backing up valuable data (but is better 
than nothing).  Modern computers are not normally supplied with this type 
of drive.  Floppy disks have almost entirely been replaced by CD or DVD 
disks. 
 
Input and Output Devices 
What are input devices? 
Input devices allow you to input information to the computer and include things such as the keyboard and 
mouse. 
 
Keyboard 
The keyboard allows you to type information into the computer. It has evolved 
over the years.  The keyboard is built into laptop computers but is a separate 
item if used with a Desktop computer.  They can be connected via cables or may 
be wireless. 
 
  
 
Mouse 
When using an operating system, such as Microsoft Windows, you use the mouse to 
select drop down menus, to point and click on items, to select items and to drag and 
drop items from one place to another. 
   
 
 
What are output devices? 
Includes items such as screens (monitors), printers, speakers and headphones. 
 
 
Traditional computer monitor 
An output device. The original computer monitors were TV type screens on which 
you viewed your programs. They were supplied in different sizes, common sizes 
range from 15" to 21" screens. You should be aware that poor quality or badly 
maintained monitors could harm your eyesight. 
 
  
Flat screen computer screens 
Traditional computer monitors are based on the same sort of technology that is 
used within a television screen. 
 
More recently, flat screen computer screens have become available. These take up 
a lot less room on a desk and use less energy than the traditional, more bulky 
monitors. 
 
You should be aware that often if you specify a screen of a certain size, say a 17-
inch screen, this is the size measured diagonally, not horizontally across the screen. 
If you are upgrading you should also ask for the "visible viewing area" of the screen. 
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Printers 
Most data is printed once you have created it and there are a vast number of different printers available to 
accomplish this. Most common are ink jet and laser printers both of which can now produce coloured output 
(at a cost). 

      
Different types of printer 
There are many different types of printers. In large organisations, laser printers are most commonly used 
because they can print very fast and give a very high quality output. In most organisations, the printers are 
connected to the computers via a network. This means that each person with a computer does not require his 
or her own printer. Each computer connected to the network can print using a particular shared printer. 
When you buy a printer, one of the things the salesperson will not necessarily stress is how much it will cost to 
keep that printer running.  Laser printers do not use ink; they use something called toner that is normally 
supplied in a sealed unit called a toner cartridge. Each toner cartridge will allow you to print a certain amount 
of pages and when the toner is used up it needs to be replaced. In some cases the costs of these toner 
cartridges is very high. Ink jet printers can work out even more expensive to run. 
 
Laser printers 
Laser printers produce high print quality at high speed. They are called "laser printers" due to the fact that 
they contain a small laser within them. There is a wide range of laser printer manufacturers and one buzzword 
to be aware of is Postscript, a type of printer that is designed to give very high quality reproduction of 
pictures. 
 
Colour laser printers 
Originally, most laser printers would only print in black and white (mono). More recently colour laser printers 
have dropped in price and are entering wide spread use. While many of these produce excellent results, you 
should be aware of the fact that the "price per page", especially if you are using a lot of colour on a page can 
be very high compared to the cost of printing in black and white. 
 

 
  
Inkjet printers 
Inkjet printers work by using tiny jets to spray ink onto the paper. Inkjet printers are very quiet in operation 
and produce print quality comparable to that of laser printers, though laser printers still have the edge in 
terms of speed. Inkjet printers are ideal for low volume printing where high quality print is required and speed 
is not a high priority, e.g. printing letters in a small office or in the home. 
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Using Excel 2010 
 
Starting the Excel program Excel 2010 

 
Click on the Start button (bottom-left of the screen). Click on All Programs. Click on Microsoft Office.  Click on 
Microsoft Excel 2010.  The Excel window will be displayed, as illustrated. 
 

  
 

What is the Active Cell? 
Excel identifies the active cell with a bold outline around the cell and highlighting the column heading letter 
and row heading number of the cell.  In the following example, B2 is the active cell: 
 

 
  
 
In the above illustration, notice that B2 is displayed in the Name Box and the contents of the cell is displayed 
in the Formula Bar.  In this case, 2002 is a calculated value, 2000+2. 
In order for you to enter data into a cell, it needs to be the active cell.  The active cell will accept keyboard 
entries.  You can make a cell active by clicking on it or navigating to it. 
 



20 
 

The Excel cell referencing system 
 
An Excel worksheet is made up of individual cells, each of which has a unique reference.  Look at the 
illustration below.  We have clicked on cell B3, which means that the cell is in column B, row 3. 
 

  
 
In the illustration below, we have clicked on cell D2. 
 

 
  
 
If you look carefully you will see that the current cell reference is displayed just above the actual worksheet. 
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Entering numbers and text 
 
Click on cell B2, as illustrated. 
 
  
 
 
 
 
 
 
 
 
 
 
Type in the word 'Region'.  Press the Enter key.  When you press 
the Enter key you will automatically drop down to the next cell 
within the worksheet.  Your screen will now look like this. 
 
 
 
 
 
 
 
 
 
 
The active cell is now B3.  Type in the word 'North'.  Press the 
Enter key. 
The active cell is now B4.  Type in the word 'South'.  Press the 
Enter key. 
The active cell is now B5.  Type in the word 'East'.  Press the Enter 
key. 
The active cell is now B6.  Type in the word 'West'.  Press the 
Enter key. 
 
Your screen will now look like this: 
 
  
 
 
Click on cell C2.  Type in the word 'Sales'.  Press the Enter key. 
Type in the number 10488 and press the Enter key. 
Type in the number 11973 and press the Enter key. 
Type in the number 13841 and press the Enter key. 
Type in the number 16284 and press the Enter key. 
 
Your screen will now look like this: 
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Default text and number alignment 

If you look carefully at what you have typed in you will see that by default text is aligned within a cell to the 
left, while numbers are aligned within the cell to the right.  This makes sense, as normally text starts from the 
left of a page and it is the same within a cell.  Numbers on the other hand normally align to the right.  Think 
how you would write down a column of numbers on a page that you want to add up.  Numbers align to the 
right. 
 

Summing a column of numbers 
 
Click on cell B7 and type in the word 'Total'. 
Click on cell C7. Click on the Formulas tab, and 
then click on the AutoSum button. 
 
  
Your screen will look like this: 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press the Enter key and Excel will automatically add up the 

column of numbers, as illustrated. 
 
  
We have hardly started to use Excel but already you have 
seen how powerful and easy to use it is.  We will see more of 
the Excel functions for performing calculations later. 
 
 
 
 
 
 
 
 
 
 
 
 
The best thing about Excel is that if you make changes to the numbers then totals and other calculations are 
automatically updated.  Click on cell C4 and type in a different number.  When you press the Enter key you will 
see that the total value displayed in cell C7 changes to recalculate the total value of the sales. 
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Entering a date 
 
Click on cell A1.  Enter the following information and then press the Enter key. 
 
“2/2/2010” 
 

  
 
Excel recognises this as a date and automatically marks the cell as containing date information. 
 
Right click over the date you have just entered.  From the popup menu displayed, select the Format Cells 
command, as illustrated. 
 

  
 
Excel recognises this as a date and automatically marks the cell as containing date information. 
 
Right click over the date you have just 
entered.  From the popup menu displayed, 
select the Format Cells command, as 
illustrated. 
 
This will display the Format Cells dialog box. 
 
  
 
If you have time you can select a different 
type of date format, using the Type section 
of the dialog box.  Click on the OK button to 
apply any changes you make. 
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Worksheets and Workbooks 
 
Look at the bottom-left of your screen and 
you will see the worksheet tabs displayed. 
 
 
  
By default each workbook contains three worksheets.  This is similar to a Notebook that contains separate 
pages.  Click on the Sheet 2 worksheet tab and the second worksheet is displayed.  Click on the Sheet 3 
worksheet tab and the third worksheet is displayed.  Click on the Sheet 1 worksheet tab and the first 
worksheet, containing your data is displayed again.  As we will see later you can add or remove worksheets as 
well as reordering and renaming them. 
 

Saving a workbook 
 
To save the workbook click on the Save icon (top-left part of your screen). 
  
This will display the Save As dialog box. 

 
  
Navigate to the folder containing your sample files.  To do this, double click on the Excel 2010 Basics folder. 
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You will see the sample files listed within the Excel 2010 Basics folder. 
 

 
  
 
Click within the File name section of the dialog box to name the file.  In this case use the file name My First 
Workbook. 
 

  
 
 
Click on the Save button to save the file to disk. 
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Closing a workbook and exiting the Excel program 
 
To close the workbook, click on the File Tab (top-left of your screen), from the drop down options displayed, 
click on the Close command. 
 

 
  
 
The screen will now look like the illustration below.  The Excel program is open but no workbook is displayed 
within the program. 
 

  
 
To close the Excel program, click on the Close icon.  This icon is the small cross displayed at the top right of the 
Excel screen. 
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Creating a new workbook 
 
Start the Excel program. Each time you start the Excel program, by default, it displays a new blank workbook 
containing three blank worksheets.   Type in your First Name in to cell A1 and press the Enter key. 
To create a new workbook, press Ctrl+N.  This is the keyboard shortcut for creating a new file. A new 
workbook will be created containing three worksheets.  Type in your Second Name in to cell A1.   
Close both workbooks without saving your changes. 
 

Opening a workbook 
 
Press Ctrl+O which is the keyboard shortcut to open an existing file. 
 
Or click on the File Tab (top-left) and then click on the Open command. 
 

 
  
This will display the Open dialog box.  Navigate to the folder called Excel 2010 Basics, (under the Documents 
folder), containing your sample files.  
Select a file called Sales 2005, and then click on the Open button to open the workbook.   
Open the workbook called Sales 2006 and also a workbook called Sales 2007.  You now have three open 
workbooks. 
 

Switching between workbooks 
 
To switch to a particular Excel workbook, click on the Excel workbook icon displayed within the Windows 
Taskbar (across the bottom of the screen).  From the popup list displayed select the required wordbook. 
 

  
 
TIP: You can use the Alt+Tab keyboard shortcut to switch between open programs. 
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Saving a workbook using another name 

Open the workbook called Sales 2005.  Click on the File Tab and then select the Save As command.   
 

 
  
 
The Save As dialog box will be displayed. 
 

  
 
In the File name section enter a new file name, in this case called My Backup.  Click on the Save button.  You 
now have two copies of the same file, both containing the same information.  This can be useful for making 
backups of your data or for retaining copies of a workbook with different versions of the data in each file. 
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Saving a workbook using a different file type 
 
Click on the File Tab and then select the Save As command.   
 
  
 
 
 
 
 
 
 
 
 
 
The Save As dialog is displayed.  Click on the down arrow within the Save as type section of the dialog box.   
 

  
 
You can select the required file type from the drop down displayed. 
  

 
 
TIP: If you want to email a copy of an Excel 2010 workbook to someone that has an earlier version of Excel, 
such as Excel 2003, then you may need to save the file in the Excel 97-2003 Workbook file format. 
 
Alternatively, people with earlier versions of Excel can download additional free software from Microsoft 
allowing them to open and view (but not necessary edit), files created using Excel 2010. 
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Other commonly used file type options include:  
 
Text file:  
Saving your worksheet as a plain text file will remove all the formatting you have added to your worksheet 
(such as bold, italics & underlining).  It will also remove any pictures or other features such as tables.  Only 
plain text will be saved.  Be very careful about using this option. 
 

  
 
Template:  
You normally save a workbook as a workbook file.  You can however save a workbook as a template.  This 
means that you can create new workbooks in the future; based on the templates you create. 
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CSV file:  
This saves table data in a form that can be used by other programs.  It is short for Comma Separated Value. 
 

  
 
Close any open dialog boxes and close all open worksheets. 
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Getting help within Excel 2010 

 
Click on the Microsoft Excel Help icon (towards the top-right of the 
screen). 
 
TIP: Or press the F1 help key. 
 

The Excel Help window is displayed. 
 
  
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you can see a wide range of help topics are displayed.   
Click on the Getting Started with Excel 2010 link.  This will 
display the following information. 
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Click on the What's new in Excel 2010? link.  You will see 
the following. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Improved Ribbon link.  You will see the following. 

 
  
 
 
 
 
 
 
 
 
 
TIP: Click on the Maximise 
button within the top-right 
part of the dialog box.  This 
will make the dialog box fill 
the screen and the 
information within it will be 
easier to read. 
 
 
 
Spend a little time browsing 
what's new within this 
version of Excel.   
When you have finished 
experimenting, close the 
Excel Help window. 
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Searching for Help 
 
You can search for help on a topic of particular interest. Press F1 to display the Excel Help window.  Within the 
text box near the top of the Excel Help window, type in a word or words relating to the help you need.  For 
instance, to display help about printing, type in the word 'printing'. 
 

 
  
 
Click on the Search button next to the text input box.   
 

 
 
  
You will see a range of topics related to printing.  Clicking on any of these topics will display more information 
about printing. 
 

  
 
Close the Excel Help window when you have finished experimenting. 
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The Help 'Table of Contents' 
 
Press F1 to display the Excel Help window. Click on the Table of Contents icon (the book icon displayed within 
the Excel Help window toolbar). 
 

  
 
You will now see a Table of Contents displayed down the left side of the Excel Help window. 
 

  
 
Take a little time learning to navigate through this table of contents. 
 
 

Printing a Help topic 
 
Display an item of interest within the Excel Help window.  Click on the Print icon displayed within the Excel 
Help toolbar. 
 

  
 
Close all open dialog boxes before continuing. 
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Alt key help 
 
Press CTRL+N to open a new blank workbook 
Click on the Home tab. 
Press the Alt key and you will see numbers and letters displayed over icons, tabs or commands, towards the 
top of your screen.   
 

 
  
If you type in a number or letter you will activate a command.  For instance in the example shown,  
the number 1 is displayed over the Save icon.  Type in 1 and you will see the Save As dialog box 
displayed.  Close this dialog box.   
Press the Alt key again and you will see an N displayed over the Insert tab.  Press N and you will see 
the contents of the Insert tab displayed. 
This is a very easy way of learning keyboard shortcuts.  You now know that Alt+1 will display the 
Save As dialog box and that Alt+N will display the Insert Tab. 
Click on the Home tab before continuing. 
 

Selection techniques 
 
Why are selection techniques important? 
Often when you want to do something within Excel you need to select an item first.  This could involve 
selecting a cell or multiple cells.  It may need you to select a row, a column or even the entire table. 
 

Selecting a cell 
 
Open a workbook called Selection techniques.  To select a cell simply click on that cell.  Thus to select cell B3, 
click on cell B3. 
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Selecting a range of connecting cells 
 
We want to select the cells 
from C3 to G3.  To do this click 
on the first cell within the 
range, i.e. C3.  Then press 
down the Shift key (and keep 
it held down).  Click on cell G3.  
When you release the Shift 
key the cell range will remain 
selected, as illustrated. 
 

 
  
 
 
 

Selecting a range of non-connecting cells 
 
Sometimes we need to select multiple cells that are not next to each other, as in the example below, where 
C3, E3 and G3 have been selected. 
 

  
 
To do this click on the first cell, i.e. C3.  Then while keeping the Ctrl key pressed click on the cells E3 and G3.  
When you release the Ctrl key the cells will remain selected. 
 
 

Selecting the entire worksheet 
 
To select the entire worksheet, click on the intersection between the column and row referencing numbers. 
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Selecting a row 
 
To select a row, say the row relating to Canada, click on the relevant row number displayed down the left side 
of the worksheet. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The selected row will look like this. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selecting a range of connecting rows 
 
To select the rows relating to Canada, USA, UK and Australia. First click on the row number next to Canada (i.e. 
5).  Press down the Shift key and keep it pressed.  Click on the row number relating to Australia (i.e. 8).   
When you release the Shift key the multiple rows remain selected. 
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Selecting a range of non-connected rows 
 
Click on the row number 3 and press down the Ctrl key.  Click on row number 5, then row number 7 and finally 
number 9.  Release the Ctrl key and the rows will remain selected. 
 

  
 

Selecting a column 
 
To select the column containing data relating to 2003, click on 
the column header C, as illustrated. 
 

  
 
 
 
 
 
 
 
 
 
 
 
The selected column will look like this. 
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Selecting a range of connecting columns 
 
To select the columns relating to the sales 
figures for 2003-2006, first select column C.  
Press the Shift key and while keeping it 
pressed select column F. When you release 
the Shift key the columns will remain 
selected. 
 

 
  
 
 
 
 
 
 

Selecting a range of non-connecting columns 
 
To select the columns relating to 2003, 2005 and 2007, first select the column C.  Press the Ctrl key and keep it 
pressed.  Select column E and then select column G. Release the Ctrl key and the columns remain selected. 
 

  
 
Close the workbook without saving any changes you may have made. 
 
 

Recommended techniques when creating or editing lists  
Each cell should contain the smallest data element.  For instance if you are storing a person’s name, use one 
cell for the first name and another cell for the second name.  This means that at a later date you could 
manipulate the data to sort by the second name.  For the same reason split the details of an address into as 
many smaller parts as possible so that later you could search by state/region , by post code/zip code or even 
by country if you are maintaining an international list. 
The top row of your data will often contain the headers of each column.  These are called field names. 
A list should not contain blank rows or columns within the data.  This can cause problems when later sorting 
your data. 
Ensure that cells bordering your list are blank. 
If your data has a bottom row which contains totals, it is often a good idea to insert a blank line above the row 
of totals. 
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 Manipulating  

 

Manipulating rows and columns 
 
Inserting rows into a worksheet 
 
Open a workbook called Rows and columns.  
We need to insert a row for Japan between 
the row for Canada and the row for the USA.  
Select the row for the USA, as illustrated. 
 

 
  
 
 
 
 
 
 
Right click over the selected row and from the popup 
menu displayed select the Insert command. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The table will now look like this. 
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Click on cell B6 and type in the word 'Japan'.  Enter the following sales figures for Japan. 

  
 
 

Inserting columns into a worksheet 
 
We want to insert a column for sales figures in 2002, which needs to be inserted before the 2003 column. 
Select the column relating to 2003, as illustrated. 
 

  
 
 
Right click over the selected column and from the popup menu displayed select the Insert command.   
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The column will be inserted, as illustrated. 
 

 
  
Enter the following data into the column. 
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Deleting rows and columns 
 
Deleting rows within a worksheet 
 
Select the row relating to Canada. Right click over the selected row and from the popup menu displayed 
select the Delete command. 
 

  
 
The row is deleted without any additional warning. 
 
TIP: To delete multiple connected rows, use the Shift key trick to select multiple rows and then right click to 
delete the rows.  To delete multiple non-connected rows, use the Ctrl key trick to select the multiple rows and 
then right click to delete the rows. 
 

Deleting columns within a worksheet 
 
Select the column relating to Sales 2007. Right click over the selected column and from the popup menu 
displayed select the Delete command.   
 

 
  
The column is deleted without any additional warning. 
 
TIP: To delete multiple connected columns, use the Shift key trick to select multiple columns and then right 
click to delete the columns.  To delete multiple non-connected columns, use the Ctrl key trick to select the 
multiple columns and then right click to delete the columns. 
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Modifying  
 
Modifying column widths 
 
Select a column, such as the Sales 2004 column. Right click over the selected column and from the popup 
menu displayed select the Column Width command. 
 

  
 
The Column Width dialog box is displayed which allows you to set the column width.  Click on the Cancel 
button to close the dialog box. 
 

  
 
 
Modifying column widths using 'drag and drop' 
 
Move the mouse pointer to the line between the header for column B and column C, as illustrated below. 
 

  
 
Press the mouse button and keep it pressed.   
 
The pointer changes to a black cross with double arrows when placed on the line between two columns. 
 
Move the mouse pointer left or right to make the column narrower or wider.  Release the mouse button and 
the column width will change as required. 



46 
 

Automatically resizing the column width to fit contents 

Resize all the columns so that they are too narrow to 
properly display the data contained within the columns.  
Your screen will look similar to the illustration below. 
 

 
 
 
 
 
 
 
 

  
To automatically resize each column width to fit the 
contents, select all the columns containing data.   
 

  
 
 
 
 
 
 
 
 
 
 

 
Double click on the junction between one of the column 
headers within the selected columns. 
 

  
 
 
 
The columns will automatically resize to accommodate the data within each column. 
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Modifying row heights 
 
Select one or more rows and then right click over the selected row(s).  From the popup menu displayed select 
the Row Height command. 
 

  
 
The Row Height dialog is displayed allowing you to set the exact row height, as required. 
 

 
  
 
TIP: If you click between any two row headers, you can drag the row height up or down as required, to modify 
the row height. 
 
Save your changes and close the workbook.  
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Manipulating cells and cell content  
 

Copying a cell or range contents within a workbook 
 
Open a workbook called 
Copying moving and deleting. 
Select a cell, range, row or 
column to copy.  In this case 
select the range B4 to E4. 
 
TIP: A range like this is often 
written as B4:E4. 
 
Your screen will look 
something like this: 
 
Press Ctrl+C to copy the 
selected range to the 
Clipboard. 
 
TIP: To copy a selected item to the Clipboard using the Ribbon, 
click on the Home tab and then click on the Copy icon in the 
Clipboard group on the Ribbon. 
 

  
 
 
Click at the location you wish to paste the data to.  In this case click on cell B14 and 
press the Ctrl+V keys to paste the data from the Clipboard. 
 
TIP: To paste an item from the Clipboard using the Ribbon, click on the Home tab 
and then click on the Paste icon, in the Clipboard group on the Ribbon. 
 
 
Your data will now look like this. 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
TIP: You can use the same technique to copy entire rows or columns.  Pressing Ctrl+A will select everything 
within a worksheet and allow you to copy the entire worksheet contents to the Clipboard when you press 
Ctrl+C. 
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Deleting cell contents 
 
Select the range that you wish to delete the 
contents of.  In this case select the range 
B10:E10, as illustrated. 
 
Press the Del key and the cell contents will 
be deleted. 
 
TIP: You can use the same technique to 
delete entire rows or column contents. 
 
Pressing Ctrl+A will select everything within 
a worksheet and allow you to delete the 
entire worksheet contents when you press 
the Del key. 
 

Moving the contents of a cell or range within a workbook 
 
Select the range you wish to move and 
then cut it to the Clipboard.  In this case 
select the data, as illustrated. 
 
Press the Ctrl+X keys to cut the selected 
data to the Clipboard. 
Click at the location you wish to move 
the selected data to, in this case click in 
cell B15, and press Ctrl+V, to paste the 
data. 
 
TIP: You can use the same technique to 
move entire rows or columns. 
 
Save your changes and close the 
workbook. 
 

Editing cell content 
 
It is easy to edit existing data within a cell or to replace existing data within a cell. Open a workbook called 
Editing. 
Click on cell B3.  Double click in front of the word 'Region' and insert the word 'Sales' followed by a space.  
Press the Enter key to commit your changes to the cell. 
Click on cell B7.  Double click on the word 'West', to select it and then over type the selected word with the 
word 'Central'.  Press the Enter key to commit your changes to the cell. 
 

Undo and Redo 
 
Click on the Undo icon (top-left of your screen) to reverse the last action.  
Try it now. 
 
Click on the Redo icon (top-left of your screen) to reapply the last action.  
Try it now. 
 
Save your changes and close the workbook. 
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Copying data between worksheets (within the same workbook) 

Open a workbook called Worksheet manipulation. 
Select a cell, range, row or column to copy.  In this case select the range B3:C8.  Your screen will look 
something like this: 
 

  
 
Press Ctrl+C to copy the selected range to the Clipboard.  Click on the second worksheet tab (called 
Projections). 
 

 
 
 You will now see the contents of the second, empty worksheet displayed. 
 
Click at the location you wish to paste the data to.  In this case click on cell C4 and press the Ctrl+V keys to 
paste the data from the Clipboard.  You have successfully copied selected data from one worksheet to 
another worksheet within the same workbook. 
 
BEFORE CONTINUING:  Click on the Undo icon to undo this copy. 
 
The Undo icon is displayed towards the top-left of your screen. 
 
Leave the workbook open and carry on to the next section. 
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Moving data between worksheets 

Moving data between worksheets (within the same workbook) 
 
Switch back to the first worksheet within the workbook called Worksheet manipulation. 
Select a cell, range, row or column to move.  In this case select the range B3:C8.  Your screen will look 
something like this: 
 

 
  
Press Ctrl+X to cut (move) the selected range to the Clipboard. 
Click on the second worksheet tab (called Projections). 
 

  
 
You will now see the contents of the second, empty worksheet displayed. 
 
Click at the location you wish to paste the data to.  In this case click on cell C4 and press the Ctrl+V keys to 
paste the data from the Clipboard.  You have successfully moved selected data from one worksheet to 
another worksheet within the same workbook. 
 
Save your changes and close the workbook. 
 
Moving data worksheets (in different workbooks) 
Open a workbook called Between workbooks 1. 
Open a second workbook called Between workbooks 2. 
Display the contents of the Between workbooks 1 workbook. 
 
NOTE: To switch between multiple open workbooks, click on the Excel icon displayed within the Taskbar at 
the bottom of the screen and click on Between Workbooks 1. 
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 Within the Between workbooks 1 workbook, select a cell, range, 
row or column to move.  In this case select the range B3:C8.  
Your screen will look something like this: 
 
Press Ctrl+X to cut (move) the selected range to the Clipboard. 
 
Switch to the second workbook (called Between workbooks 2). 
Click at the location you wish to paste the data to.  In this case 
click on cell C4 and press the Ctrl+V keys to paste the data from 
the Clipboard.  You have successfully moved selected data from 
one workbook to another workbook. 
 
NOTE: You could have selected a different worksheet within the 
second workbook if you wanted. 
 
Copying data between worksheets (in different workbooks) 
Select the data in the second workbook. 
Press Ctrl+C to copy the selected data to the Clipboard. 
Switch back to the first workbook. 
Click where you wish to paste the data to. 
Press Ctrl+V to paste the data from the Clipboard. 

 
You have now copied selected data from one workbook to another workbook. 
 

 
Auto Fill 
 
Open a workbook called AutoFill. 
Click on cell B3 which contains the word Monday.  
 
 
 
 
 
 
 
 
 
 
 
 
Move the mouse pointer to the bottom-right corner of this cell and the 
mouse pointer shape will change to the shape of a small black cross.  
When the mouse pointer changes shape, press the mouse button down, 
and while keeping it pressed move slowly down the page to cell B7.  
When you release the mouse button you will see that Excel has 'Auto 
Filled' the range you dragged across with days of the week. 
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Click on cell C3 which contains the word January.   
 

  
 
 
 
 
 
 
Use the AutoFill feature to automatically create a column 
containing all the months of the year. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the cell range D3:D4.   
 

 
 
 
 
 
 
Use AutoFill to extend the series down the page.  As you will 
see the series becomes 1,2,3,4,5,6,7 etc. 
 

  
 
 
 
 
 
 
 
 
 
 
 
Select the cell range E3:E4.   
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Use AutoFill to extend the series down the page.  As you will see the series becomes 2,4,6,8,10 etc. 
 

  
 
Save your changes and close the workbook. 
 

 
Renaming a worksheet 
 
Click on the Sheet1 tab to display the first worksheet. Double click on the Sheet1 tab. 
 

  
 
The worksheet tab will be highlighted and you will be able to type in a new name.   
 

  
 
In this case type in the name 2008 and then press the Enter key to confirm the change, as illustrated. 
 

  
 
Double click on the Sheet2 tab and rename it 2009. 
Double click on the Sheet3 tab and rename it 2010.  Your tabs will now look like this: 
 

  
 
By default worksheets are called Sheet1, Sheet2 and Sheet3.  You should use meaningful names for your 
worksheets, especially if you are using multiple worksheets within a workbook.  This can make a complicated 
workbook much easier to understand. 
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Inserting a new worksheet 
 
Click on the 2010 worksheet tab to select it.  Right click over the tab and from the popup menu displayed, click 
on the Insert command. 
 

 
 
  
The Insert dialog is displayed.  Make sure that the Worksheet object is selected within the dialog box. 
  

 
 

Then Click Ok button to insert a New worksheet 
 
 

Deleting a worksheet 
 
Make sure that the new tab that you have just inserted is selected.  Right click on the tab and from the popup 
menu displayed select the Delete command.  The new worksheet will be deleted. 
 

  




